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For information on how to use Help, press F1 or select Using Help from the Help menu.



Presentation

DirectAudio Player or DAP is an AU / WAV / GSM file Player utility which features 
DirectAudio, real time playing of GSM6.10, and, if run under Windows 95, Microsoft GSM, 
and True Speech    encoded audio files from any HTTP (WWW) server on the Internet.

Under Windows 3.x, it supports any Microsoft WAV file formats, Sun/Next .AU (8000 Hz/ 8bits 
µ law encoded) files, and can also receive, expand and play in real time.GSM6.10 encoded 
files. 

If run under Windows 95 it will also support (play, record, stream) Ms GSM files at 8000, 11025,
22050 and 44100 Hz as weel as True Speech ™ files (no recording support), using the built in 
audio codecs. The higher sampling rate Ms GSM format files offer a much better audio quality 
than the 8000 Hz or TrueSpeech files.

When run under Windows 95, DAP also supports the True Speech ™ description files (.TSP) 
so that you can use it to play all of the current True Speech files available on the Internet !

 The easy to use interface, provides seek and play features at the touch of a slider bar. Support 
for Drag and Drop allows you to play or convert any AU, WAV, GSM or TrueSpeech file by 
dragging them from Windows' file manager and dropping them on DAP's client window area.



Streaming Audio and DirectAudio
Streaming Audio refer to a way of delivering and playing audio files on a computer network 
which allows to play an audio file while it is beeig sent instead of requiring to first download the 
file to a local disk. This applied to the Internet, allows to deliver audio on demand progams 
from any WWW server on the net. Using DirectAudio doesn't require any special server 
software since it uses the same protocol used by the WWW servers to deliver HTML pages to 
your browser (HTTP).

There are a few conditions that must be satisfied to make uninterrupted streaming audio 
possible:

- The digital sound stream must be equal or smaller, in terms of required bandwith, than 
the available network bandwith.
- The server must be able to deliver a steady stream of the required bandwith.
- The client must be fast enough to receive, decode and play the received stream.

DAP use a buffer of user selectable size to help against network transmission irreguarity by 
gathering a given number of seconds of sound before it starts to play the audio stream. It will 
use this buffer whenever the network chain fails to deliver the audio stream fast enough. In such
case the buffer will get used up until it becomes empty. At this point, the playing stop for the time
needed for the player to refills its buffer. The playing can then resume.

The next table gives the required bandwith for each of the supported streamable formats. The 
required bandwith represent the minimum throughput required to play uninterrupted streaming 
audio. It does not represent an absolute requirement as the higher resolutions will work on 
slower connections but not without interruption.

Format / Sampling Rate Required Bandwith Quality Internet Connection

True Speech (Win 95) 8536 bps Low 14,400 and over
GSM 6.10 (Win3.x/Win 95) 13200 bps Low 14,4000 and over
Ms GSM 8000 (Win 95) 13000 bps Low 14 000 and over
Ms GSM 11025 (Win 95) 17912 bps Medium 28,800 and over
Ms GSM 22050 (Win 95) 35824 bps Medium-High 56,000 - 64000 and over
Ms GSM 44100 (Win 95) 71656 bps High 128000 and over



Listening to DirectAudio files.
There are two methods for accessing a GSM or TrueSpeech file from a HTTP (WWW) server:

1 -By selecting the File|Open Location option on the main menu and entering the full URL of 
the file you wish to fetch. For instance:

http://www.cam.org/~noelbou/ex1.gsm
will fetch the example ex1.gsm from my WWW site on my service provider's server.

If run under Windows 95, you can also receive Ms GSM and True Speech Files:
Try the following URLs

http://www.cam.org/~noelbou/audio/dixi_8g.wav(Ms GSM at 8000 Hz)
http://www.cam.org/~noelbou/audio/dixi_11g.wav (Ms GSM at 11025 Hz)
http://www.cam.org/~noelbou/audio/dixi_22g.wav (Ms GSM at 22050 Hz)
http://www.cam.org/~noelbou/audio/dixi_44g.wav (Ms GSM at 44100 Hz)
http://www.cam.org/~noelbou/audio/dixi_8ts.wav (True Speech)

 You can use your browser and Windows' Cut & Paste feature to make this easier. Copy 
the desired link (In your browser, right click on the desired URL and select Copy Link) and 
paste it using [SHIFT-INSERT] in DAP's File|Open Location input dialog.

2 By clicking on a "description file" link (see below) on a WWW page. For instance:

A link to the EX1.GSD file on a WWW page would fetch the description file named ex1.GSD 
from the WWW site.DAP would then be spawned by your WWW browser and the file would 
instruct the player on which GSM file to fetch from the net.



Credits
DirectAudio Player's Design and Programming:

Noël Bouchard
TELE DATA Consultants
Copyright January-August 1996
email: noelbou@cam.org
WWW: http://www.cam.org/~noelbou

DAP uses an implementation of the European GSM 06.10 provisional standard for fullrate 
speech transcoding, which uses RPE/LTP (residual pulse excitation/long term prediction) coding
at 13 kbit/s to provide support for GSM6.10. The library has been written by:

Jutta Degener (jutta@cs.tuberlin.de) and Carsten Bormann(cabo@cs.tuberlin.de).

Here's the library authors' copyright notice:

Any use of this software is permitted provided that this notice is not removed and that neither 
the authors nor the Technische Universitaet Berlin are deemed to have made any 
representations as to the suitability of this software for any purpose nor are held responsible for 
any defects of this software.

THERE IS ABSOLUTELY NO WARRANTY FOR THIS SOFTWARE.

Berlin, 15.09.1992
Jutta Degener(jutta@cs.tuberlin.de)
Carsten Bormann(cabo@cs.tuberlin.de)

Communications and Operating Systems Research Group, TU Berlin
Fax: +49.30.31425156, Phone: +49.30.31424315



Contacts
Your comments on this release of the DirectAudio Player would be very appreciated.

Please address your bug reports, suggestions, or any other comments to:

Noël Bouchard
TELE DATA Consultants
Montréal, Québec

email: noelbou@cam.org
WWW: http://www.cam.org/~noelbou

Voice: (514) 527-1201
Fax: (514) 527-2657



Release Information

Version Number

DirectAudio Player Version 2.0

Your feedback / comments / suggestions / bug reports would be very appreciated ... See 
Contacts 



Information about GSM 6.10
The speech coding algorithm used in GSM is based on a rectangular pulse excited linear 
predictive coder with long-term prediction (RPE-LTP).

This is a lossy compression algorithm devised especially for speech. The quality of the 
algorithm is good enough for reliable speaker recognition . Music can also be compressed with 
a quite noticeable loss in the high frequency spectrum and a result that has been qualified to 
sound like "AM to Low quality FM" radio sound.

GSM 06.10 full rate compress 8000 Hz sampling rates / 16 bits samples PCM encoded files 
(128000 bits / sec.) to 13200 bits / sec. A 9.69 ratio. That means that the GSM file will be almost
10 times smaller than the original PCM (WAV) file !



Play Menu

The Play menu provides commands to control the playing of sound files. You can also use the 
toolbox buttons which duplicates this menu options.

Rewind Go toward the beggining of the file.
Stop Stop playing the file and rewind to beggining.
Play Start or Resume playing the file.
Pause Pause Playing.
Forward Go toward the end of the file.



File Menu

The File menu provides commands to open files for Playing, fetch audio files from a WWW 
server and exit the application.

Open Open an existing file.
Open Location Fetch a GSM file from the Net.
Save As Save a downloaded file.
Exit Exit DAP application.



Options Menu

Display Units
Select the units to display file size and position.

Drag/Drop Action
Select the action triggered when a file is dropped from the file 
manager.

BufferSizeSet the buffer size. This can be set from 1 to 32 secs. 
Set this to a higher number will help in adverse network condition. 
DAP will wait until the given amount of sound has been received 
before starting to play.

Dont Ask to Save
Skip the "File has not been saved" dialog on exit.

Always On Top
Keep DAP window on top of all others. Usefull in many situation 
particularly when using the Drag/Drop feature from the file 
manager.

Automatic Volume Control
This option may be usefull when listening to audio recorded at a 
too low level. It will ajust the sound level to the maximum 
permisible before clipping occurs. This option is also usefull when 
recording directly from a microphone. 

Note: This function has been designed to improve the inteligibility 
of speech files recorded over a telephone interface. It should be 
used selectively as it will alter the audio dynamics significantly and
can produce some perceptible "clicks" in the audio. This option is 
not available with Ms GSM or True Speech files and will have no 
effect when used. 

The status line will display AVC On on playing or recording when 
AVC is active.



Stats Menu

The stats menu opens the following Streaming Audio Statistics window:

Actual Throughput:
This is a graphical display of the number of bits per second that is 
actually getting to your machine from the server. The horizontal 
scale represents time, the vertical scale represents the actual 
thoughput. Each vertical green line represent 1 second. The top 
line represents 0 bits per seconds and the bottom one is the 
maximum scale which varies according to the received format. 
The red line represents the required bandwitdh to get 
uninterrupted audio. Once the display is full it will shift to the left 
and display the new throughput to the right. This way you have a 
display of the throughput over the last several seconds.

Buffer State:
This displays the proportion the buffer that is filled with received 
data. The player will stop to refill its buffer when it gets close to 0.

Required Bandwidth:
That is the "network chain" bandwith required to receive 
uninterrupted audio from the server. This will vary according to the
format beeing received.

Buffer Size:
The number of second that will be buffered as configured in the 
General Options.



Help Menu

The Help menu provides access to the help system and the about dialog.

Contents Help topic contents.



Exiting
To exit the application, choose File|Exit from the menu.



Drag/Drop from the File Manager 
A file can be Played, by dragging it from the File Manager, and dropping it on DAP's main 
window.

In Windows 3.x, you can also minimize DAP window so that the icon is displayed on the 
desktop, drag a file from Window's file manager and drop it on the icon.



File Exit Command

The File|Exit command exits DAP.



 File Open Command

The File|Open command displays the Open a File dialog box so you can select a file to Play. 
An Open file dialog will be displayed that will let you select an input file. You can select a drive 
and directory from the list on the right.    You can select the file format by selecting from the list
under the file list in the open dialog window. You can select the file name from the list or type it 
in the input box.



 File Open Location Command
The File|Open Location command is used to fetch an audio file from a HTTP server on the net. 
The file will then be played in real time. You must enter the full URL of the GSM6.10, Ms GSM 
or TrueSpeech file that you whish to hear. 

For instance: http://www.cam.org/~noelbou/ex1.gsm
would fetch the file Ex1.GSM    in directory ~noelbou of host www.cam.org.

Under Windows 95 you can also listen in real time to Microsoft GSM (.WAV) and True 
Speech(.WAV): 

http://www.cam.org/~noelbou/audio/dixi_11g.wav (Ms GSM 11025 example file)

The file must be available from a WWW server for this to work this will not work on a FTP 
server. i.e.
ftp://ftp.cam.org/anyfile.gsm    would not work since this is an FTP server URL.

Hint: You can use Windows' and your browser's Cut & Paste feature to paste an URL in the 
Input Box. Right click on the desired link on an HTML page from your browser and select Copy 
Link Location (or similar) function and then paste the location in DAP's input dialog using the 
[SHIFT-INSERT] key combination



File Save As

The File|Save As command is used to save a downloaded file. It will be available only after a 
file has been downloaded. Note that you can't save a streamed file. To save a file residing on a 
WWW site, it must be downloaded first.



Options Display Units

The Display Units option let you select the unit used to display the file size and position. You can
select one of the following values:

Bytes:
This selection display the numbers as bytes. This setting is usefull for comparisons of files 
sizes.

Samples:
The numbers are displayed as the number and current samples.    

Seconds:
The numbers are displayed as hours:minutes:seconds..



Playing a file from the Command line

You can play a file by giving its pathname on the command line argument. In the file manager, 
select the File|Run command and type:

DAP "PathName"

Example: DAP c:\audio\gsm\ex1.gsm

You can also install DAP as you .AU, WAV, GSM, Ms GSM and TrueSpeech format audio 
player in your Internet browser. DAP will be launched after a .AU, WAV or GSM file has been 
downloaded to let you hear it
.



DAP Shortcuts Keys
You can use the following shortcut keys to get a quicker access to DAP functions.

KEYS FUNCTION

ENTER Play
SPACE Stop
ALT SPACE Pause

ALT-A Save As
ALT-L Open Location
ALT-X Exit

CTL-B Display Units as Bytes
CTL-S Display Units as Seconds
CTL-M Display units as Samples
CTL-V Toggle Automatic Volume Control

F1 Help
F2 File Open
F3 Open Location
ALT-F4 Exit
F5 Options Dialog
F8 Open Stats. window



Windows 95
codecs Installing the Ms GSM and TRUESpeech ™ codecs

Use the following steps to enable the Microsoft GSM 6.10 Audio Codec audio compression 
driver: 

1. In Control Panel, double-click Multimedia. 
2. Click the Advanced tab. 
3. Double-click the Audio Compression Codecs branch to expand it. 
4. Double-click Microsoft GSM 6.10 Audio CODEC. 
5. Click Use This Audio Codec. Make sure the "ALL Rates" is selected for Compression and 
Decompression. You can also use the Auto-Configure to have window evaluate the fastest 
speed it can support on compression and decompression.
6. Click Apply and OK.

Do the same for DSP Group TrueSpeech ™ Software CODEC.



Help table of contents
The Help|Contents displays the help contents page.



Licence
Installation of the DirectAudio Player is contingent on your (The "Recipient" hereinafter)
agreement to the following terms:

This agreement is a binding legal agreement between TELE DATA Consultants and the 
purchasers, users or evaluators.    If you do not intend to honor this agreement, remove all 
installed TELE DATA Consultants software from your computer now.

1- Grant of Licence

TELE DATA Consultants, grants to Recipient a limited, non-exclusive, royalty-free licence 
provided that the Recipient is an individual and is using the software for personal use only.

It is strictly forbidden to use this product in a commercial application or to bundle it with an 
application or CD-ROM or any other commecial uses, without obtaining a licence from TELE 
DATA Consultants. 
Please contact us to inquire about our low priced volume licencing. 

User Agreement

You may allow other users to evaluate copies of the unregistered Shareware. All evaluation 
users are subject to the terms of this agreement.

The evaluator/user/buyer/owner is not allowed to attempt to reverse engineer, disassemble or 
decompile TELE DATA Consultants Software and products. 

All parts of TELE DATA Consultants software and products are copyright protected.    No 
program, code, part, image, audio sample or text or may be copied or used in any way by the 
user except as intended within the bounds of the single user program.

The evaluator/user/buyer/owner of TELE DATA Consultants software will indemnify, hold 
harmless, and defend TELE DATA Consultants against lawsuits, claims, costs associated with 
defense or accusations that result from the use of TELE DATA Consultants software.

TELE DATA Consultants is not responsible for any damages whatsoever, including loss of 
information, interruption of business, personal injury and/or any damage or consequential 
damage without limitation, incurred before, during or after the use of our products.    Our entire 
liability, without exception, is limited to the customers' reimbursement of the purchase price of 
the software (maximum being the suggested retail price as listed by TELE DATA Consultants) in
exchange for the return of the product, all copies, registration papers and manuals, and all 
materials that constitute a transfer of ownership from the customer back to TELE DATA 
Consultants.

 Distribution

DirectAudio Player is copyrighted software. You may freely use any and all of the files in the 
DirectAudio Player distribution, and you may freely distribute the unaltered ZIP distribution file.
However, you may not distribute for profit or use the applicartion in a profit oriented organisation
without obtaining a licence from TELE DATA Consultants If you wish to do this, please contact 



us.

You may freely distribute the archived package provided that:

(1) Such distribution includes only the original archive supplied by TELE DATA Consultants   
You may not alter, delete or add any files in the distribution archive.

(2)  No money is charged to the person receiving the software, beyond reasonable cost of 
packaging and other overhead.



The Toolbar
The Toolbar is a row of buttons at the top of the main window which represent application commands. 
Clicking one of the buttons is a quick alternative to choosing a command from the menu.    Buttons on 
the toolbar activate and deactivate according to the state of the application.

Button Action Menu Equivalent

Locate and open a file. File|Open

Fetch a GSM file on the Net. File|OpenLocation

Go toward the beggining of the file. Play|Rewind

Stop Playing. Play|Stop

Start or Resume playing. Play|Play

Pause Playing. Play|Pause

Go toward the end of file. Play|Forward

Display help file contents. Help|Contents



Windows Keys
Cursor Movement Keys
Dialog Box Keys
Editing Keys
Help Keys
Menu Keys
System Keys
Text Selection Keys
Window Keys



Cursor Movement Keys

Key(s) Function

Arrow key Moves the cursor left, right, up, or down in a field.
End or Ctrl+Right Arrow Moves to the end of a field.
Home or Ctrl+Left Arrow Moves to the beginning of a field.
Pape Up or Page Down Moves up or down in a field, one screen at a time.



Dialog Box Keys

Key(s) Function

Tab Moves from field to field (left to right and top to bottom).
Shift+Tab Moves from field to field in reverse order.
Alt+letter Moves to the option or group whose underlined letter matches 

the one you type.
Arrow key Moves from option to option within a group of options.
Enter Executes a command button.

Or, chooses the selected item in a list box and executes the 
command.

Esc Closes a dialog box without completing the command. (Same as
Cancel)

Alt+Down Arrow Opens a drop-down list box.
Alt+Up or Down Arrow Selects item in a drop-down list box.
Spacebar Cancels a selection in a list box.

Selects or clears a check box.
Ctrl+Slash Selects all the items in a list box.
Ctrl+Backslash Cancels all selections except the current selection.
Shift+ Arrow key Extends selection in a text box.
Shift+ Home Extends selection to first character in a text box.
Shift+ End Extends selection to last character in a text box



Editing Keys

Key(s) Function

Backspace Deletes the character to the left of the cursor.
Or, deletes selected text.

Delete Deletes the character to the right of the cursor.
Or, deletes selected text.



Help Keys

Key(s) Function

F1 Gets Help and displays the Help Index for the application. If the 
Help window is already open, pressing F1 displays the "Using 
Windows Help" topics.
In some Windows applications, pressing F1 displays a Help topic
on the selected command, dialog box option, or system 
message.

Shift+F1 Changes the pointer to  so you can get Help on a specific 
command, screen region, or key. You can then choose a 
command, click the screen region, or press a key or key 
combination you want to know more about.

(This feature is not available in all Windows applications.)



Menu Keys

Key(s) Function

Alt Selects the first menu on the menu bar.
Letter key Chooses the menu, or menu item, whose underlined letter 

matches the one you type, when a menu has focus.
Alt+Letter key Pulls down the menu whose underlined letter matches the one 

you type.
Left or Right Arrow Moves among menus of the main menu bar.
Up or Down Arrow Moves among menu items within a drop-down menu.
Enter Chooses the selected menu item.



System Keys

The following keys can be used from any window, regardless of the application you are 
using.

Key(s) Function

Ctrl+Esc Switches to the Task List.
Alt+Esc Switches to the next application window or minimized icon, 

including full-screen programs.
Alt+Tab Switches to the next application window, restoring applications 

that are running as icons.
Alt+PrtSc Copies the entire screen to Clipboard.
Ctrl+F4 Closes the active window.
F1 Gets Help and displays the Help Index for the application. (See 

Help Keys)



Text Selection Keys

Key(s) Function

Shift+Left or Right Arrow Selects text one character at a time to the left 
or right.

Shift+Down or Up Selects one line of text up or down.
Shift+End Selects text to the end of the line.
Shift+Home Selects text to the beginning of the line.
Shift+Page Down Selects text down one window.

Or, cancels the selection if the next window is 
already selected.

Shift+Page Up Selects text up one window.
Or, cancels the selection if the previous 
window is already selected.

Ctrl+Shift+Left or Right Arrow Selects text to the next or previous word.
Ctrl+Shift+Up or Down Arrow Selects text to the beginning (Up Arrow) or end

(Down Arrow) of the paragraph.
Ctrl+Shift+End Selects text to the end of the document.
Ctrl+Shift+Home Selects text to the beginning of the document.



Window Keys

Key(s) Function

Alt+Spacebar Opens the Control menu for an application window.
Alt+Hyphen Opens the Control menu for a document window.
Alt+F4 Closes a window.
Alt+Esc Switches to the next application window or minimized icon, 

including full-screen programs.
Alt+Tab Switches to the next application window, restoring applications 

that are running as icons.
Alt+Enter Switches a non-Windows application between running in a 

window and running full screen.
Arrow key Moves a window when you have chosen Move from the Control 

menu.
Or, changes the size of a window when you have chosen Size 
from the Control menu.






